










86 Human Interface Guidelines

After a split, the document appears the same, except for the split line
lying across it. But there are now separate scroll bars for each pane.
The panes are still scrolled together in the orientation of the split,
but can be scrolled independently in the other orientation. For
example, if the split is horizontal, then horizontal scrolling (using
the scroll bar along the bottom of the window), is still synchronous.
Vertical scrolling is controlled separately for each pane, using the
two scroll bars along the right of the window. This is shown in Figure
14.
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Scrolling a Split Window

To remove a split, the user drags the split bar to the bottom or the
right of the window.

The number of views in a document doesn't alter the number of
selections per document: that is, one. The active selection appears
highlighted in all views that show it. If the application has to
scroll automatically to show the selection, the pane that should be
scrolled is the last one that the user· clicked in. If the selection is
already showing·in one of the panes, no automatic scrolling takes
place.

Panels

If a document window is more or less permanently divided into different
regions, each of which has different content, these regions are called
panels. Unlike panes, which show different parts of the same document
but are functionally identical, panels are functionally different from
each other but might show different interpretations of the same part of
the document. For example, one panel might show a graphic version of
the document while another panel shows a textual version.

1/15/85 Tognazzini /INTF/WINDOW



WINDOWS 87

Panels can behave much like subwindows; they can have scroll bars, and
can even be split into more than one pane. An example of a panel with
scroll bars is the list of files in the Open dialog box.

Whether to use panels instead of separate windows is up to the
application. Multiple panels in the same window are more compact than
separate windows, but they have to be moved, opened, and closed as a
unit.
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Once the information to be operated on has been selected, a command to
operate on that information can be chosen from lists of commands called
menus.

The Apple II's pull-down menus have the advantage that they're not
visible until the user wants to see them; at the same time they're easy
for the user to see and choose items from.

Most commands either do something, in which case they're verbs or verb
phrases, or else they specify an attribute of an object, in which case
they're adjectives. They usually apply to the current selection,
although some commands apply to the whole document or window.

When you're designing your application, don't assume that everything
has to be done through menu commands. Sometimes it's more appropriate
for an operation to take place as a result of direct user manipulation
of a graphic object on the screen, such as a control or icon.
Alternatively, a single command can execute complicated instructions if
it brings up a dialog box for the user to fill in.

The Menu Bar

The menu bar is displayed at the top of the screen. It contains a
number of words and phrases: These are the titles of the menus
associated with the current application. Each application has its own
menu bar. The names of the menus do not change, except when the user
calls for a desk accessory that uses different menus.

Only menu titles appear in the menu bar. If all of the commands in a
menu are currently disabled (that is, the user can't choose them), the
menu title should be dimmed (in gray type or flanked by the ASCII 127
checkerboard). The user can pull down the menu to see the commands,
but can't choose any of them.

Choosing Menu Commands

••• With A Mouse

To choose a command, the user positions the pointer over the menu title
and presses the mouse button. The application highlights the title and
displays the menu, as shown in Figure 15.
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Figure 15. Menu

While holding down the mouse button, the. user moves the pointerd6wn
the menu. As the pointer moves to each command, the command is
highlighted. The command that's highlighted when the user releases the
mouse button is chosen. As soon as the mouse button is released, the
command blinks briefly, the menu disappears, and the command is
executed. The menu title in the menu bar remains highlighted until the
command has completed execution.

Nothing actually happens until the user chooses the command; the user
can look at any of the menus.without making a connnitment to do
anything.

The most frequently used commands should be at the top of a menu;
research shows that the easiest item for the mouse user to choose is
the second item from the top. The most dangerous commands should be at
the bottom of the menu, preferably isolated from the frequently used
commands •

••• With the Cursor Keys

Pressing Escape within the application moves the user to the last item
chosen on the menu. When the application begins, the initial cursor
location should be the title of the first menu. Once at the menu, the
user can move up and down the current menu with the Up and Down cursor
keys, and move to the top of the adjacent menus using the Left or Right
cursor keys. Once the user has reached the desired item, it is
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selected by pressing Return. If the user is on the title of a menu or
on a disabled item when Return is pressed, no. action will be taken.

The user may also select an item when in the menu pressing it's
keyboard equivalent key (see: Keyboard Equivalents, below). The
keyboard equivalent command will be carried out and the menu operation
will be cancelled. The user can choose simply to cancel the menu
operation by pressing Escape to return .to the application.

Escape is normally defined on the Apple II as, "move me one level up in
the program". This definition is retained in windowing software, as
Escape will cancel dialog boxes, current inputs, and so forth. The
only addition is that when the user is already at the top level (the
application), it will toggle between application and menu.

If a command can be chosen directly from the keyboard, it's followed by
the Open-Apple, Solid-Apple, or Control key (diamond) symbol and the
character used to choose it. To choose a command this way, the user
holds down the appropriate modifier key and then presses the character
key.

Whenever practical, make all keyboard equivalents be Open-Apple
combinations. If you want to provide a keyboard macro capability, let
the user program macros to the Solid-Apple key. Otherwise, accept
Solid-Apple keystrokes for Open-Apple commands. Avoid assigning two
different commands to the same. key, with only the use of Open- or
Solid-Apple to differentiate. Generally, users do not recognize the
difference between the two modifier keys.

While the toolkits enable you to use control characters for keyboard
equivalents, we generally recommend against it for the following
reasons:

- Most control keys are either tied to the hardware of the computer
or are otherwise reserved. (See: Control combinations.)

- The diamond symbol for control is not generally recognized by
users.

- Control keys are generally reserved for basic, simple, repetitive
functions, such as moving by or deleting individual characters.

The advantage to control keys is their typeability: the current
location of the Open- and Solid-Apple keys is such that they are
difficult to touch-type with any speed or accuracy. We therefore
recommend that you reserve control keys for only those things that must
be done repetitively and unconciously. We suggest that even in these
cases, you also enable the same key used with Open-Apple, as we have
done with cut, copy, and paste. This tends to make documenting and
learning easier, with the experienced user picking up the control
shortcut at an appropriate time.
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Reserved Key Combinations

Some characters are reserved for special purposes, but there are
different degrees of stringency. Since almost every application has a
File menu and an Edit menu, the keyboard equivalents in those menus are
strongly reserved, and should never be used for any other purpose. All
these equivalents may be selected while pressing the Open-Apple key.
(All but Quit are also selectable while pressing the Control key, to
enable touch-typists to manipulate the mouse while using these editing
keys simultaneously):

Character

z
X
C
V

Q

Command

Undo (Edit menu)
Cut (Edit menu)
Copy (Edit menu)
Paste (Edit menu)

Quit (File menu)

The following Open-Apple combinations are reserved for the keyboard
equivalents of mouse operations:

Character

D
G
M

Command

Drag or move the currently active window
Grow or shrink (size) the currently active window
Mark a selection

One Open-Apple keyboard command doesn't have a menu equivalent:

Character Command

Stop current operation

Other Open-Apple keyboard equivalents are conditionally reserved. If
an application enables these commands, it shouldn't use these
characters for any other purpose, but if it doesn't, it can use them
however it likes:

Open-Apple combinations:

Character Command

P Print
S Save
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Control combinations:

Character

R
C
D
E
F

* H
* I
* J
* K

L

* M

P

S

* U
V

x

z

* [

Command

Bold
Copy
Delete
Edit
Forward Delete

Left Arrow
Tab
Down Arrow
Up Arrow
Begin or End Underline
Carriage Return

Print the contents of the screen

Save

Right Arrow
Paste

Cut

Undo

Escape

* These are the control equivalents of the various Apple special keys.
Current unmodified Apple II keyboards cannot differentiate between a
Control-character sequence and its equivalent special key, for example,
Control-M and Return.

Appearance of Menu Commands

The commands in a particular menu should be logically related to the
title of the menu. In addition to command names, three features of
menus help the user understand what each command does: command groups,
toggles, and special visual features.

Command Groups

As mentioned above, menu commands can be divided into two kinds: verbs
for actions and adjectives for attributes. An important difference
between the two kinds of commands is that an attribute stays in effect
until it's cancelled, while an action ceases to be relevant after it
has been performed. Each of these two kinds can be grouped within a
menu. Groups are separated by lines, which are implemented as disabled
commands.
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The most basic reason to group commands is to break up a menu so it's
easier to read. Commands grouped for this reason are logically
related, but independent. Commands that are actions are usually
grouped this way, such as Cut, Copy, Paste, and Clear in the Edit menu.

Attribute commands that are interdependent are grouped to show this
interdependence. Two kinds of attribute command groups are mutually
exclusive groups and accumulating groups.

In a mutually exclusive attribute group, only one command in the group
is in effect at the same time. The command that's in effect is
preceded by a check mark. If the user chooses a different command in
the group, the check mark is moved to the new command. An example is
the Font menu in MacWrite; no more than one font can be in effect at a
time.

In an accumulating attribute group, any number of attributes can be in
effect at the same time. One special command in the group cancels all
the other commands. An example is the Style menu in MacWrite: the
user can choose any combination of Bold, Italic, Underline, Outline, or
Shadow, but Plain Text cancels all the other commands.

Toggles

Another way to show the presence. or absence of an attribute is by a
toggled command. In this case, the attribute has two states, and a
single command 'allows the user to toggle between the states. For
example, when rulers are showing in MacWrite, a command in the Format
menu reads "Hide Rulers". If the user chooses this command, the rulers
are hidden, and the command is changed to read "Show Rulers". This
kind of group should be used only when the wording .of the commands
makes it obvious that they're opposites.

Special Visual Features

In addition to the command names and how they're grouped, several other
features of commands communicate information to the user:

- A check mark indicates whether an attribute command is currently
in effect.

- An ellipsis ( ••• ) after a command name means that choosing that
command brings up a dialog box. The command isn't actually
executed until the user has finished filling in the dialog box and
has clicked the OK button or its equivalent.

- The application dims a command (or flanks it with the ASCII 127
checkerboard) when the user can't choose it. If the user moves
the pointer over a dimmed item, it isn't highlighted.

- If a command can be chosen from the keyboard, it's followed by the
specific modifier key symbol (Open-Apple, Solid-Apple, or diamond
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symbol for Control) and the character used to choose it.

The application can draw its own type of menu. An example of this is
the Fill menu in MacDraw.

STANDARD MENUS

One of the strongest ways in which applications can take advantage of
the consistency of the windowing user interface is by using standard
menus. The operations controlled by these menus occur so frequently
that it saves considerable time for users if they always match exactly.
Three of these menus, the? or Solid-Apple, File, and Edit menus,
appear in almost every application.

The~ Solid-Apple Menu
.-,. fill'. I otJ. nou.s.eT.tZ.n"" C-H,4f'<./lc.TeJ2s" ::rex
(4 in a MouseText-based application, Solid-K'pple in a graphics-based
application)

Desk accessories are mini-applications that you may make available to
your user while using your application. You can enable a user to issue
a command at any time to call up one of several desk accessories. More
than one accessory can be on the desktop at a time. An example of a
menu of accessories is shown in Figure 16.

Rbout MousePalnt ...
....- - _-_ ..

Scrapbook
Alarm Clock
NotePad
Calculator
Puzzle

Figure 16. Apple Menu

The? menu also contains the "About xxx" menu item, where "xxx" is the
name of the application. Choosing this item brings up a dialog box
with the name and copyright information for the application, as well as
any other information the application wants to display.
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The File Menu

The File menu allows the user to perform certain simple filing
operations. It also contains the commands for printing and for leaving
the application. The standard File menu includes the commands shown in
Figure 17.

New
Open•••

._-.._ _- ..

Close
Hide
Soue
Saue As•••
Reuert to Saued

...............__ - _ .

Poge Setup •••
Print... oP

Ouit OQ

Figure 17. File Menu

Other frequently used commands are Print Draft, Print Final, and Print
One. All of these commands are described below.

New

New opens a new, untitled document. The user names the document the
first time it's saved. This command is disabled when the maximum
number of documents allowed by.the application is already open.

Open opens an existing document. To select the document, the user is
presented with a dialog box (Figure 18). This dialog box shows a list
of all the documents on the disk whose name is displayed that can be
handled by the current application. The user can scroll this list
forward and backward. The dialog box also gives the user the chance to
look at the documents on other disks in other disk drives that belong
to the current application.
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Figure 18. Open Dialog Box

Using the Open command, the user can only open a document that can be
processed by the current application. Opening a document that can only
be processed by a different application requires leaving the
application.

This command is disabled when the maximum number of documents allowed
by the application is already open.

Close

Close closes the active document or desk acceSsory. If the user has
changed the document since the last time it was saved, the command
presents an alert box giving the user the choice of whether or not to
save the changes.

Clicking in the close box of a window is the same as choosing Close.

Save

Save makes permanent any changes to the active document since the last
time it was saved. It leaves the document open.

If the user chooses Save for a new document that hasn't been named yet,
the application presents the Save As dialog (see below) to name the
document, and then continues with the save. The active document
remains active.

If there's not enough room on the disk to save the document, the
application asks if the user wants to save the document on another
disk. If the answer is yes, the application goes through the Save As
dialog to find out which disk.
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Save As

Save As saves a copy of the active document under a file name provided
by the user.
\
If the document already has a name, Save As closes the old version of
the document, creates a copy, and displays the copy in the window.

If the document is untitled, Save As saves the original document under
the specified name. The active document remains active.

Revert to Saved

Revert to Saved returns the document to the state it was in the last
time it was saved. Before doing so, it puts up an alert box to confirm
that this is what the user wants.

Page Setup

Page Setup lets the user specify printing parameters such as what the
document's paper size and printing orientation are. These parameters
remain with the document.

Print

Print lets the user specify various parameters such as print quality
and number of copies, then prints the document. The parameters apply
only to the current printing operation.

Quit

Quit leaves the application. If any open documents have been changed
since the last time they were saved, the application presents the same
alert box as for Close, once for each document.

Other Commands

Other commands that are in the File menu in some applications include:

- Print Draft. This command prints one copy of a rough version of a
document more quickly than Print. It's useful in applications and
with printers where ordinary printing is slow. If an application
has this command, it should change the name of the Print command
to Print Final.

- Print One. This command saves time by printing one copy using
default parameters without bringing up the Print dialog box. If
an application has this command, Open-Apple-P should be its
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The Edit Menu

The Edit menu contains the commands that delete, move, and copy
objects, as well as commands such as Undo, Show Clipboard, and Select
All. This section also discusses the Clipboard, which is controlled by
the Edit menu commands. Text editing methods that don't use menu
commands are discussed under "Text Editing".

The standard order of commands in the Edit menu is shown in Figure 19.

Undo (183t) Z

cut
Copy
Paste
Clear

OH
OC
au

Show Clipboard
Select All

Figure 19. Edit Menu

The Clipboard

The Clipboard is a special kind of window with a well-defined function:
it holds whatever is cut or copied from a document. Its contents stay
intact when the user changes documents, opens a desk accessory, or
leaves the application. An application can choose whether to have the
Clipboard open or closed when the application starts up.

The Clipboard looks like a document window, with a close box but with
no scroll bars. Its contents cannot be edited.

Every time the user performs a Cut or Copy on the current selection, a
copy of the selection replaces the previous contents of the Clipboard.
The previous contents are kept around in case the user chooses Undo.

The user can see the contents of the Clipboard but can't edit them. In
most other ways the Clipboard behaves just like any other window.

There is only one Clipboard, which is present for all applications that
support Cut, Copy, and Paste. The user can see the Clipboard window by
choosing Show Clipboard from the Edit menu. If the window is already

1/15/85 Tognazzini IINTF/SMENUS



STANDARD MENUS 99

showing, it's hidden by choosing Hide Clipboard. (Show Clipboard and
Hide Clipboard are a single, toggled command.)

Undo

Undo reverses the effect of the previous operation. Not all operations
can be undone; the definition of an undoable operation is somewhat
application-dependent. The general rule is that operations that change
the contents of the document are undoable, and operations that don't
are not. Most menu items are undoable, and so are typing sequences.

A typing sequence is any sequence of characters typed from the keyboard
or numeric keypad, including Delete, Return, and Tab, but not including
keyboard equivalents of commands.

Operations that aren't undoable include selecting, scrolling, and
splitting the window or changing its size or location. None of these
operations interrupts a typing sequence. That is, if the user types a
few characters and then scrolls the document, the Undo command still
undoes the typing. Whenever the location affected by the Undo
operation isn't currently showing on the screen, the application should
scroll the document so the user can see the effect of the Undo.

An application should also allow the user to undo any operations that
are initiated directly on the screen, without a menu command. This
includes operations controlled by setting dials, clicking check boxes,
and so on, as well as drawing graphic objects with the mouse.

The actual wording of the Undo command as it appears in the Edit menu
is "Undo xxx", where xxx is the name of the last operation. If the
last operation isn't a menu command, use Sbme suitable term after the
word .Undo. If the last operatibn can't be undone, the command reads
"Undo", but is disabled.

If the last operation was Undo, the menu command says "Redo xxx", where
xxx is the operation that was undone. If this command is chosen, the
Undo is undone.

Cut

The user chooses Cut either to delete the current selection or to move
it. If it's a move, it's eventually completed by choosing Paste.

When the user chooses Cut, the application removes the current
selection from the document and puts it in the Clipboard, replacing the
Clipboard's previous contents. The place where the selection used to
be becomes the new selection; the visual implications of this vary
among applications. For example, in text, the new selection is an
insertion point, while in an array, it's an empty but highlighted cell.
If the user chooses Paste immediately after choosing Cut, the document
should be just as it was before the cut; the Clipboard is unchanged.
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When the user chooses Cut t the application doesn't know if it's a
deletion or the first step of a move. Therefore t it must be prepared
for either possibility.

Copy is the first stage of a copy operation. Copy puts a copy of the
selection in the Clipboard t but the selection also remains in the
document.

Paste

Paste is the last stage of a copy or move operation. It pastes the
contents of the Clipboard to the document t replacing the current
selection. The user can choose Paste several times in a row to paste
multiple copies~ After a paste t the new selection is the object that
was pasted t except in text t where it's an insertion point immediately
after the pasted text. The Clipboard remains unchanged.

Clear

When the user chooses Clear t the application removes the selection t but
doesn't put it on the Clipboard. The new selection is the same as it
would be after a Cut.

Show Clipboard

Show Clipboard is a toggled command. Initiallytthe Clipboard isn't
displayed t and the command is "Show Clipboard". If the user chooses
the command t the Clipboard is displayed and the command changes to
"Hide Clipboard".

Select All

Select All selects every object in the document.

Font-Related Menus

Three standard Macintosh menus affect the appearance of text: Font t
which determines the font of a text selection; FontSize t which
determines the size of the characters; and Stylet which determines
aspects of its appearance such as boldface t italics t and so on.

Because of the proliferation of printers on the Apple II familYt you
may find it too expensive to implement the kind of power and range of
font options available on the Macintosh. We have still including the
full specification; use that portion necessary for y~ur particular
application.
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Font Menu

A font is a set of typographical characters created with a consistent
design. Things that relate characters in a font. include the thickness
of vertical and horizontal lines, the degree and position of curves and
swirls, and the use of serifs. A font has the same general appearance,
regardless of the size of the characters. The Font menu always lists
the fonts that are currently available. Figure 20 shows a Font menu
with some of the most common fonts.

Chicago
GenelJa

v"New York
Monaco
Uentce
lontlon
Rthens

Figure 20.

FontSize Menu

Font sizes are measured in points; a point is about 1/72 of an inch.
Each font is available in predefined sizes. The numbers of these sizes
for each font are shown outlined in the FontSize menu. The font can
also be scaled to other sizes, but it may not look as good. Figure 21
shows a FontSize menu with the standard Macintosh font sizes.

9 potnt
10

v'U?2
14
18
24
36
48
12

Figure 21. FontSize Menu
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If there's insufficient room in the menu bar for the word FontSize. it
can be abbreviated to Size. If there's insufficient room for both a
Font menu and a Size menu. the sizes can be put at the end of the Font
or Style menu.

Style Menu

The commands in the Style menu are Plain Text. Bold, Underline, Italic,
Outline. and Shadow. The first three are reasonably implemented on
most printers and should be considered standard on Apple. All the
commands except Plain Text are accumulating attributes; the user can
choose any combination. They are also toggled commands; a command
that's in effect for the current selectiori is preceded by a check mark.
Plain Text cancels all the other choices. Figure 22 shows these
styles. II software.

MouseText

.......Ploili TeHt
Bold
I folic
Underline
IDmnDOmm
"[llQjCOQJ[,W

Figure 22.

P
tB
01
tl
00
OS

Style Menu

If you are working in a MouseText-based toolkit, mark the beginning and
end of a font-related change with.the s?lid"'diamond character. As the
user passes over this character. open a view box to let the user see
what the particular change is. (See: View Boxes under Dialogs and
Alerts)

Figure 22A. MouseText Example

TEXT EDITING

In addition to the operations described under "The Edit Menu" above,
there are other ways to edit text that don't use menu items.
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Inserting Text

To insert text, the user selects an insertion point by clicking where
the text is to go, then starts typing it. Alternatively, the user can
move the current insertion point location, using the cursor key~, and
then resume typing. As the user types, the application continually
moves the insertion point to the right of each new character.

Applications with multiline text blocks should support word wraparound,
according to the definition of a word detailed above under "Selecting a
Word". The intent is that no word be broken between lines.

Delete

When the user presses the Delete key (or Control-D), one of two things
happens:

- If the current selection is one or more characters, it's deleted.

If the current selection is an insertion point, the previous
character is deleted.

In both cases, the deleted characters don't go into the Clipboard, and
the insertion point replaces the deleted characters in the document.

Forward Delete

When the user presses Control-F, one of two things happens:

- If the current selection is one or more characters, it's deleted
(exactly as with Delete).

- If the current selection is an insertion point, the character to
the right of the insertion point is deleted. (The cursor in a
MouseText-based program is a blinking underscore. Since the
underscore itself is to the right of the insertion-point, the
effect is that the character immediately above the underscore is
deleted.)

In both cases, the deleted characters don't go into the Clipboard.

Replacing Text

If the user starts typing when the selection is one or more characters,
the characters that are typed replace the selection. The deleted
characters don't go into the Clipboard, but the replacement can be
undone by immediately choosing Undo.
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Intelligent Cut and Paste

An application that lets the user select a word by double-clicking
should also see to it that the user doesn't regret using this feature.
The only way to do this is by providing "intelligent" cut and paste.

To understand why this feature is necessary, consider the following
sequence of events in an application that doesn't provide it:

1. A sentence in the user's document reads: "Returns are only
accepted if the merchandise is damaged." The user wants to change
this to: "Returns are accepted only if the merchandise is·
damaged."

2. The user selects the word "only" by double-clicking. The letters
are highlighted, but not either of the adjacent spaces.

3. The user chooses Cut, clicks just before the word "if", and
chooses Paste.

4. The sentence now reads: "Returns are accepted onlyif the
merchandise is damaged." To correct the sentence, the user has to
remove a space between "are" and "accepted", and add one between
"only" and "if". At this point he or she may be wondering why
Apple computers are supposed to be easier to use than other
computers.

If an application supports intelligent cut and paste, the rules to
follow are:

- If the user selects a word or a range of words, highlight the
selection, but not any adjacent spaces.

- When the user chooses Cut, if the character to the left of the
selection is a space, discard it.

- When the user chooses Paste, if the character to the left of the
current selection isn't a space, .add a space. If the charac ter to
the right of the current selection isn't a punctuation mark or a
space, add a space. Punctuation marks include the period, comma,
exclamation point, question mark, apostrophe, colon, semicolon,
and quotation mark.

This feature makes more sense if the application supports the full
definition of a word (as detailed above under "Selecting a Word"),
rather than the definition of a word as anything between two spaces.

These rules apply to any selection that's one or more whole words,
whether it was chosen with a double-click or as a range selection.

Figure 23 shows some examples of intelligent cut and paste.
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Exernple 1:

1. Select e word, Drink to me with thine eyes.

2, Choose Cut. Drink to mel with thine eyes.

3, .Select an in~tion point. Drink to me with ~hine eyes.

-4. Ch003e Pe3te. Drink to me with only Ithine eyes.

Example 2:

1. Select e word How, brown cow

2. Choo3e Cut. How,l brown cow

3. Select an in5ertion point How~ brown cow

-4. Choose Peste. How now~ brown cow

Figure 23. Intelligent Cut and Paste

Editing Fields

If an application isn't primarily a text application, but does use text
in fields (such as in a dialog box), it may not be able to provide the
full text editing capabilities described so far.

It's important, however, that whatever editing capabilities the
application provides under these circumstances be upward-compatible
with the full text editing capability. The following list shows the
capabilities that can be provided, going from the minimal to the most
sophisticated:

The user can move around using the cursor keys or mouse.

- The user can select the whole field and type in a new value.

- The user can backspace delete.

The user can forward delete.

- The user can select a substring of the field and replace it.

- The user can select a word by double-clicking.

- The user can choose Undo, Cut, Copy, Paste, and Clear, as
described above under "The Edit Menu". In the most sophisticated
version, the application implements intelligent cut and paste.
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An application should also perform appropriate edit checks. For
example t if the only legitimate value for a field is a string of
digits t the application might issue an alert if the user typed any
nondigits. AlternativelYt the application could wait until the user is
through typing before checking the validity of the contents of the
field. In this case t the appropriate time to check the field is when
the user clicks anywhere other than within the field.

DIALOGS ALERTS

The "select-then-choose" paradigm is sufficient whenever operations are
simple and act on only one object. But occasionally a command will
require more than one object t or will need additional parameters before
it can be executed. And sometimes a command won't be able to carry out
its normal function t or will be unsure of the user's real intent. For
:these special circumstances the windowing user interface includes three
additional features:

- dialogs t to allow the user to provide additional information
before a command is executed

- alerts t to notify the user whenever an unusual situation occurs

- view t to enable the user of a text-based program to "look inside"
the diamond icon

Since all of these features lean heavily on controlstcontrols are
described in this section t even though controls are also used in other
places.

Controls

Friendly systems act by direct cause-and-effect; they do what they're
told. Performing actions on a system in an indirect fashion reduces
the sense of direct manipulation. To give users the feeling that
they're in control of their machines t many of a windowing application's
features are implemented'with controls: graphic objects that, when
directly manipulated by the mouse, cause instant action with visible
results.

There are four main types of controls: buttons, check boxes t radio
buttons, and dials. These four kinds are shown in Figure 24.
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IYI Check Box 1 em mmm-£lI:il Check Box 2 DialDllIls Check Box 3

o RrJdio Button 1
IButton 1 ~I

~ RrJdio Button 2
IButton 2 escl

IButtonl Jj
IButton 2 eit j

~ Check BOH 1

~ Check BOH 2

~ Check BOH 3

o Radio Button 1

[!J Radio Button 2

o Radio Button :3

MouseGraphics .t1ouseText

Figure 24. Controls

Buttons

Buttons are small objects, usually inside a window, labeled with text.
Clicking or pressing a button performs .the action described by the
button IS label.

Buttons perform instantaneous actions, such as completing operations
defined by a dialog box or acknowledging error messages. Conceivably
they could perform continuous. actions, in which case the effect of
pressing on the button would be the same as the effect of clicking it
repeatedly.

Two particular buttons, OK and Cancel, are especially important in
dialogs and alerts; they're discussed under those headings below.

Check Boxes and Radio Buttons

Whereas buttons perform instantaneous or continuous actions, check
boxes and radio buttons let the user choose among alternative values
for a parameter.

Check boxes act like toggle switches; they're used to indicate the
state of a parameter that must be either off or on. The parameter is
on if the box is checked, otherwise it's off. The check boxes
appearing together in a given context are independent of each other;
any number of them can be off or on.

Radio buttons typically occur in groups; they're round and are filled
in with a black circle when on. (In a MouseText-based program, they
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are rectangular and are filled in with a white rectangle when on.)
They're called radio buttons because they act like the buttons on a car
radio. At any given time, exactly one button in the group is on.
Clicking one button in a group turns off the current button.

Both check boxes and radio buttons are accompanied by text that
identifies what each button does.

Dials

Dials display the value, magnitude, or position of something in the
application or system, and optionally allow the user to alter that
value. Dials are predominantly analog devices, displaying their values
graphically and allowing the user to change the value by dragging an
indicator; dials may also have a digital display.

The most common example of a dial is the scroll bar. The indicator of
the scroll bar is the scroll box; it represents the position of the
window over the length of the document. The user can drag the scroll
box to change that position.

Dialogs

Commands in menus normally act on only one object. If a command needs
more information before it can be performed, it presents a dialog box
to gather the additional information from the user. The user can tell
which commands bring up dialog boxes because they're followed by an
ellipsis ( ••• ) in the menu.

A dialog box is a rectangle that may contain text, controls, and icons.
There should be some text in the box that indicates which command
brought up the dialog box.

Other than explanatory text, the contents of a dialog box are all
objects that the user sets to provide the needed information. These
objects include controls and text fields. When the application puts up
the dialog box, it should set the controls to some default setting and
fill in the text fields with default values, if possible. One of the
text fields (the "first" field) should be highlighted, so that the user
can change its value just by typing in the new value. If all the text
fields are blank, there should be an insertion point in the first
field.

Editing text fields in a dialog box should conform to the guidelines
detailed above, under "Text Editing".

When the user is through editing an item:

- Pressing Tab accepts the changes made to the item, and selects the
next item in sequence.
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- Clicking in another item accepts the changes made to the previous
item and selects the newly clicked item.

Dialog boxes are either modal or modeless, as described below.

Modal Dialog Boxes

A modal dialog box is one that the user must explicitly dismiss before
doing anything else, such as making a selection outside the dialog box
or choosing a command. Figure 25 shows a modal dialog box.

esclICancel

Print the document OP l'-O_oK_" -+J_1

G 8 1/2" xii" pllper

o 8 1/2" x 11" paper

[Xl stop printing llfter ellch page

Title: Annual ReporL _

Pri nt the document: OP (OK ~)

008 1/2" x II" paper ~---~

08 1/2" x 14" paper [Cancel esc]

t8J stop printing llfter each pllge

Title: IAnnual Reportl

MQUseGraRbics MouseText

Figure 25. A Modal Dialog Box

Because it restriet:s the user' s fR~~d()tlti9r.~ction, this type of dialog
box should be used sparingly. In particular, the user can't choose a
menu item while a moda.l dialog box is up, and therefore can only do the
simplest kinds of text editing. .

For these reasoIls~ the main use of a modal dialog box is when it's
important for the user to complete an operation before doing anything
else.

A modal dialog box usually has at least two buttons: OK and Cancel.
clicking on OK or pressing Return dismisses the dialog box and performs
the ot.iginal commandac:cordirig to the information provided; it can be
given a more descriptive name than "OK". Clicking on Cancel or
pressing Escape dismisses the dialog box and cancels the original
command; it must always be called "Cancel".

A dialog box can have other kinds of buttons as well; these mayor may
not dismiss the dialog box.

[Note to reviewers: Because of the needs of keyboard users, I have
tentitively decided to make OK always be selectable with Return and
Cancel always be selectable with Escape. This is in conflict with the
MacIntosh guideline that follows:

"One of the buttons in the dialog box may be outlined boldly. The
outlined button is the default button; if no button is outlined, then
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the OK button is the default button. The default button should be the
safest button in the current situation. Pressing the Return or Enter
key has the same effect as clicking the default button. If there is no
default button, then Return and Enter have no effect."

If you have any ideas on how we could retain the MacIntosh guideline
and still make the boxes reasonable for the keyboard user, please let
me know.]

A special type of modal dialog box is one with no buttons. This type
of box is just to inform the user of a situation without eliciting any
response. Usually, it would describe the progress of an ongoing
operation. Since it has no buttons, the user has no way to dismiss it.
Therefore, the application must leave it up long enough for the user to
read it before taking it down again.

Modeless Dialog Boxes

A modeless dialog box allows the user to perform other operations
without dismissing the dialog box. Figure 26 shows a modeless dialog
box.

o
Find text:

Change to:

Guide lines

guidelines

[Change all

(Change next

(Cancel esc]

Figure 26. A Modeless Dialog Box

A modeless dialog box is dismissed by clicking in the close box or by
choosing Close when the dialog is active. The dialog box is also
dismissed implicitly when the user chooses Quit. It's usually a good
idea for the application to remember the contents of the dialog box
after it's dismissed, so that when it's opened again, it can be
restored exactly as it was.

Controls work the same way in modeless dialog boxes a~ in modal dialog
boxes, except that buttons never dismiss the dialog box. In this
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context, the OK button means "go ahead and perform the operation, but
leave the dialog box up", while Cancel usually terminates an ongoing
operation.

A mode1ess dialog box can also have text fields; since the user can
choose menu commands, the full range of editing capabilities can be
made available.

Alerts

An alert box looks like a modal dialog box, except that it's somewhat
narrower and appears lower on the screen. An alert box is primarily a
one-way communication from the system to the user; the only way the
user can respond is by clicking buttons. Therefore alert boxes might
contain dials and buttons, but usually not text fields, radio buttons,
or check boxes. Figure 27 shows a typical alert box.

escl

101<
IConcel

CRUTION

Rre you sure
you want to erase all
changes to. your document?

Figure 27. An Alert Box

How the buttons in an alert box are labeled depends on the nature of
the box. If the box presents the user with a situation in which no
alternative actions are available, the box has a single button that
says OK. Clicking this. button means "I have read the alert." If the
user is given alternatives, then typically the alert is phrased as a
question that can be answered "yes" or "no". In this case, buttons
labeled Yes and No are appropriate~ although some variation such as
Save and Don't Save is also acceptable. OK and Cancel can be used, as
long as their meaning isn't ambiguous.

[As noted above, the following paragraph needs to be excised if we go
with the "OK equals Return" scheme.]

The preferred (safest) button to use in the current situation is boldly
outlined. This is the alert's default button; its effect occurs if the
user presses Return or Enter.

For further information on beeps, the types of alert messages, and how
and when to write one, read Alert Messages in the Generic Interface
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.-
View Boxes

MouseText-based programs have a restricted ability to deliver
what-you-see-is-what-you-get: standard printer features such as bold,
underline, and super- and subscript are impossible to produce on the
text screen. To enable the user to see where such changes begin and
end, flank the changed area with a pair of solid-diamond icons. These
icons let the user know that there is some control information at those
locations, but not what the information is.

The user can
a view box.
buttons. It
icon:

"look through the keyhole" of the diamond icon by opening
A view box looks like an alert box, except it has no
displays the information hidden within the solid-diamond

"Begin Underline" "End Bold Text" "Begin Plain Text"

The view box is normally located beginning two lines below the icon's
position, so that the user need look no further than necessary to see
it. (The single unaffected line below the diamond enables the user to
continue seeing the diamond in context.) Horizontally, approximately
one-third of the view box should lie to the left of the diamond;
two-thirds, to the right. This position relative to the icon should be
as consistent as possible throughout your application: move(it abov.e
or slide it toward one side only when you lack room on the display for
its normal position.

The contents of a view box cannot be edited. The diamond icon itself
(along with its contents) can be deleted in the same manner as any
other text character, and a new icon can be created with the
appropriate menu command.

The user can open a view box in one of two ways:

- By moving the insertion point to the left of the diamond icon. In
this position, the blinking underscore is directly beneath the
diamond icon. (Recall that the insertion point itself lies
between characters; the blinking underscore is a necessary
compromise with the text hardware and appears under the character
to the right of the insertion point.) The view box remains open
until the insertion point is moved away from the icon, the mouse
cursor is moved, or any valid short-cut key is pressed. In all of
these cases, the view box remains closed until the user formally
reopens it: it is not suddenly reopened when the mouse stops
moving.

- By covering the diamond with the mouse cursor. It is irrelevant
whether the mouse button is pressed or not: if the mouse cursor is
over the diamond, the view box is opened. This enables the user
to quickly view all diamonds on the display without having to
relocate the insertion point, and lets the user see the
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information in the same way whether simply moving the cursor
around or actively marking a selection. The view box remains open
until either the mouse cursor or the insertion point moves, or
until any valid shortcut key is pressed.

DO'S AND DON'TS OF A FRIENDLY USER INTERFACE

Do:

- Let the user have as much control as possible over the appearance
of objects on the screen--their arrangement, size, and visibility.

- Use verbs as menu commands.

- Make alert messages self-explanatory.

- Use controls and other graphics instead of just menu commands.

- Take the time to use good graphic design; it really helps.

Don't:

- Overuse modes, including modal dialog boxes.

Require using the keyboard for an operation that would be easier
with the mouse, or require using the mouse for an operation that
would be easier with the keyboard.

- Change the way the screen looks unexpectedly, especially by
scrolling automatically more than necessary.

- Make up your own menus and then give them the same names as
standard menus.

- Take an old-fashioned prompt-based application and pass it off as
a mouse-based application.
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